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目的 

時系列 InSAR解析（SBAS法）の操作方法を説明します。 

2枚の画像で処理を行う DInSAR(差分干渉 SAR)解析でも地面の変動を捉えますが、時系

列干渉 SAR解析では変動の時間的変化を監視することを目的とした解析手法です。また、

多数の画像を使用するため、処理中にノイズや大気の影響を考慮し低減します。 

SBAS法の特徴としては、差分干渉 SAR 処理と同様にフィルタ処理や干渉画像のアンラッ

プ処理を行います。複数のペアから得た位相情報から、大気による遅延の位相成分と高さ

の残差による位相成分を除去し、平均速度と高さを算出します。また、変動を算出するモ

デルは線形および非線形の選択が可能です。 

 

利用バージョン 

本マニュアルの操作は、SARscape 5.5(build 5.5.2)と ENVI 5.5.2を使用します。 

 

使用データ 

本チュートリアルでは、Sentinel-1（TOPSARモード、アセンディング）データを使用し

ます。データの観測期間は、2015 年 4月から 2019年 6月までの約 4 年間となります。観

測範囲は、神奈川県横浜市周辺のエリアとなります。 

 

事前準備 

ENVIの Preferences 設定と SARscape の Preferences設定を行います。 

ENVI Preferences設定： 

File → Preferences → Directories → Input/Output/Temporary Directoryへ使用するフ

ォルダの設定を行います。 

SARscape Preferences設定： 

Toolbox → SARscape → Preferences → Preferences specific → Load Preferences 
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Load Preferencesにて使用するデータに適切な設定を指定してください。今回は

「Sentinel TOPSAR」を選択してください。 

各設定項目について以下表へ説明を記載します。 

 

表 1. Preference Specific設定 

Load Preferences 項目 説明 

General 入力データタイプに合わせて特に調整されていない、一般的な

パラメータ設定です 

Stereo Stereo-Radargrammetry処理時に設定します 

VHR (better than 10m) 10m/pixel以下の高解像度データに適しています 

HR (between 10m and 30 m) 10m~30 m/pixelの高解像度データに適しています 

MR (coarser than 30m) 数十m~100m/pixelの中解像度データに適しています 

Interferometry-LowCoherence コヒーレンスが低いまたはクロスコリレーションを使用してコ

レジストレーションを行う場合に画像内に目立つフィーチャが

制限されている干渉データペアに適しています 

WrongOrbitalData 軌道パラメータの信頼性が低い干渉データセットまたはコレジ

ストレーションのマルチテンポラル振幅シリーズに適していま

す 

TanDEM-X Bistatic Configuration バイスタティックモードでの Â TerraSAR-X + Â Tandem-Xで

取得された干渉データペアに適しています 

CInSAR ERS-ASAR interferometry ERSと ASARによって作成された干渉データペアに適してい

ます 

SENTINEL TOPSAR TOPSAR(IW)モードで取得した Sentinelデータの干渉処理を

実施する場合この設定は必須です 

PALSAR2 ScanSAR ScanSARモードで撮影された Palsar 2 SLCの干渉処理を実施

する場合この設定は必須です 

TSX ScanSAR ScanSARモードで撮影された TerraSAR-Xの干渉処理を実施

する場合この設定は必須です 

Squinted data Squinted data(PALSAR-1, JAXA SLC配信)の場合この設定は

必須です 
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処理概要 

SBASの処理フローについて、以下図に示します。この処理フローは SARscapeの SBAS

の処理メニューと同じ順に記載しており、各フローにおける詳細や手順については後続の

章において説明します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

1 – Connection Graph 

時間、軌道間距離のベースライン算出 

2 – Interferometric Process 

干渉画像作成 

3 - Refinement and Reflattening 

精密軌道補正と位相のオフセット計算 

および位相画像の再計算 

4 - Inversion First Step 

速度推定（1回目） 

5 - Inversion Second Step 

速度推定（2回目） 

6 - Geocoding 

ジオコーディング 
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コネクショングラフ 

SBASを実施する際の最初の必須ステップです。この機能は複数の画像に対して干渉処理

を行うための干渉ペアを定義します。通常、コネクショングラフ内で線が繋がっているペ

アが使用されます。SBAS法では、時間のベースラインが小さく、軌道間距離が小さいペ

アを選出し、時間間隔での不干渉性を回避し、高さへの感度を下げることにより精度よく

変動を算出します。コネクショングラフの処理終了後には、Auxiliary.sml ファイルが出力

されます。Auxiliaryファイルは SBASの処理を管理するファイルです。実行されたステ

ップ、出力されたデータの情報などが含まれ、本処理以降は Input Fileへ Auxiliaryファ

イルを選択し処理を進めます。 

 

【操作】 

 ENVIツールボックス → SARscape → Interferometric Stacking → SBAS → 1 

- Connection Graph を選択し、ワークフローダイアログを起動してください。 

 

図 1.コネクショングラフの設定ダイアログ 

 Input Filesタブ → Input File Listの Browse をクリック → ファイルの選択ダイ

アログから、ファイルを選択し、「開く」をクリックしてください。 
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図 2. ファイル選択 

 

 マスタを指定する場合は、Optional Files にファイルを指定してください。ここで指

定する画像は、Input Files でも指定されている必要があります。ここで指定したマ

スタはスーパーマスタと呼ばれます。スーパーマスタは全ての処理において参照デ

ータとなり、このデータを元にスラントレンジ画像の位置合わせを行います。指定

しない場合は SARscape が全データから一つスーパーマスタを抽出します。 

 

図 3. マスタデータ選択タブ 

 

 コネクショングラフを算出する際の設定項目は、Parametersタブにあります。デー

タの条件などが異なる場合は設定が必要になる場合がありますが、事前準備の

SARscape Preference 設定で使用するデータに合ったものを読み込んでいるため、

基本的にはデフォルトのままで問題ありません。今回の処理も値を変更せずに実行

します。 
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図 4. Parametersタブ 

Parametersタブの Principal Parameters について簡単な説明を以下に記載します。 

⚫ Normal Baseline: 通常の基線長に対する設定で、センサにも依存しますが、

Critical Baseline の最大 45～50%まで大きくできます。 

⚫ Temporal Baseline: 時系列の基線長を設定する項目です。観測日の間隔があいて

いてコネクショングラフが繋がらない場合に調整することが可能です。 

⚫ Allow Disconnected Blocks: 取得したデータの一部がメインのコネクションに含ま

れず、別のコネクションになっている場合は、Allow Disconnected Blocks オプシ

ョンを有効にすることで時間的間隔が開いた別のコネクションも変動の算出に追加

することが可能です。その補間は第一変動速度推定の処理時に Linearや

Quadraticなどのモデルを適用します。そのため、算出された結果の変動の信頼性

は Allow Disconnected Blocks オプションを無効にしている時よりも低くなりま

す。 

⚫ Delaunay 3D: この先の処理で三次元アンラッピングの手法を使用する場合は、

Delaunay 3Dを True にしてください。出力結果グラフが一つ増え、タイムポジシ

ョンドロネー三次元プロットが表示されます。Delaunay 3D設定を Trueにする場

合、以下の設定に Highが入っていることを確認してください。 

Parametersタブ > Other Parameters > Degree of Redundancy > High 

 

 Output Files タブにてファイルの出力先を設定し、「Exec」ボタンをクリックして

ください。 
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図 5. 出力先設定タブ 

 

 処理が終了すると、レポートとコネクショングラフが表示されます。グラフには、

スーパーマスタの表示（黄色のポイント）、入力データの取得日(X 軸)の軌道間距離

（Y軸）を示すタイムポジションプロットと軌道間距離(Y軸)と入力データの取得日

(X軸)を示すタイムベースラインプロットが表示されます。処理にはコネクショング

ラフが繋がっているデータを使用します。また、タイムポジションプロットの接続

は、一つの接続に対して平均的に約５接続程あることが推奨されます。 

 

図 6. タイムポジションプロット 
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図 7. タイムベースラインプロット 

【補足】 

SBAS処理では通常、コネクショングラフ内で線が繋がっているペアが使用されますが、

軌道間距離(Normal Baseline)が広すぎる場合や、観測日の間隔が長くあいている場合など

は、コネクショングラフが繋がらないことがあります。その場合、Allow Disconnected 

Blocksを有効にする方法の他、Normal Baselineと Temporal Baseline のパラメータ調整

を行い、コネクショングラフを繋げる方法もあります。軌道間距離が広くコネクショング

ラフが繋がらない場合は、ParametersタブにあるMax Normal Baseline の割合を増やす

か、該当データを除外することが考えられます。観測日の間隔によってコネクショングラ

フが繋がらない場合は、Parametersタブにある Temporal Baselineの期間を大きくし、

コネクショングラフが繋がるように調整が可能です。ただし、期間を長く設定することに

より画像全体のコヒーレンスが悪くなり、その結果、干渉性も悪くなる可能性がありま

す。 

 

干渉画像作成処理 

SBASを実行する際の二つ目の必須ステップです。このステップでは、自動的にコネクシ

ョングラフで決定した干渉ペアデータの処理を行います。 

干渉画像作成処理では以下の処理が実施されます。 

➢ インターフェログラム生成（コレジストレーション） 

➢ コヒーレンス画像作成と干渉画像のフィルタリング 

➢ フェーズアンラッピング 
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処理が終了すると、auxiliary.sml が保存されているフォルダへ interferogram_stacking フ

ォルダが作成され、処理結果はこのフォルダに格納されます。 

 

【操作】 

 ENVIツールボックス → SARscape → Interferometric Stacking → SBAS → 2 - 

Interferometric Process を選択し、ワークフローダイアログを起動してください。 

 

図 8. 干渉画像作成設定ダイアログ 

 

 Input Filesタブ → Auxiliary Filesの横にあるフォルダマークをクリック → ファ

イルの選択ダイアログ → コネクショングラフで出力された auxiliary.sml ファイル

を選択 → 「開く」をクリックしてください。 

 

図 9. auxiliaryファイル選択ダイアログ 

 

 次に、DEMの設定を行います。DEM/Cartographic System タブ → DEM Fileの

横にあるフォルダマークをクリック → ファイルの選択ダイアログから、DEMファ
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イルを選択 → 「開く」をクリックしてください。SARscape で使用する DEMは楕

円体高である必要があります。 

 

図 10. DEM選択タブ 

 

 DEMが用意されていない場合は、同じダイアログ画面の双眼鏡アイコン をクリ

ックします。ダウンロードする DEMを選択すると、DEM Extractionツールが起動

し、インターネット上に公開されている DEMをダウンロードすることができま

す。今回用意されている DEMは、SRTM−3 Version 4をダウンロードしたもので

す。ダウンロードしたデータは楕円体高に変換されています。 

 

図 11. ダウンロードする DEMの選択ウィンドウ 

 

 その他の設定値を変更する場合は、Parametersタブで設定を行います。データの条

件などが異なる場合は設定が必要になる場合がありますが、基本はデフォルトのま

まで問題ありません。値を変更せずに実行します。 
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図 12. Parametersタブ設定 

Parametersタブの Principal Parametersについて簡単な説明を以下に記載します。 

⚫ Range/Azimuth Looks:レンジ・アジマスのルックス数を設定します。デフォルト

値は、Preference 設定でセンサに合ったルックス数が入力されています。 

⚫ Grid Size for Suggested Looks: 解像度(m)を設定します。デフォルト値は、ルッ

クスに合った解像度が入力されています。 

⚫ Rebuild All: 全てのデータを使用し、再処理を行います。一度処理を実行した後に

パラメータなどの変更をし、再度処理を実施する場合は、Trueにして実行しま

す。既に処理済みのデータに対して、新しいデータを追加して処理する場合は、

Falseを設定します。 

⚫ Coregistration with DEM: Trueの場合、コレジストレーション処理時に DEMを

使用します。 

⚫ Unwrapping Method: アンラッピングの手法を Region Growing、Minimum Cost 

Flow、Delaunay MCF から選択します。 

⚫ Unwrapping 3D: 三次元アンラッピング手法を使用します。コネクショングラフの

Delaunay 3Dを True にした場合に使用可能です。 

⚫ Unwrapping Decomposition Level: マルチルック及びアンダーサンプリングの反

復回数を指定します。 

⚫ Unwrapping Coherence Threshold: アンラッピングの際にこの値より低い全ての

ピクセルがマスクされます。 

⚫ Filtering Method: フィルタリングの手法を Adaptive window、Boxcar window、

Goldsteinから選択します。 

 

 「Exec」ボタンをクリックし、処理を実行してください。 
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Refinement and Re-flattening処理 

軌道補正と位相のオフセット計算し、位相画像の再計算を実施します。 

ここでは Refinment処理で使用する GCPを作成する手順が含まれています。GCPは基準

点(変動解析であれば不動点)の設定と、ノイズ除去と軌道補正を目的としています。GCP

の配置は、変動のエリアは避け、コヒーレンスが高いピクセルを選択し、画像全体に 20 点

程取得します。 

 

【操作】 

 ENVIツールボックス → SARscape → Interferometric Stacking → SBAS → 3 - 

Refinement and Re-Flatteningを選択し、ワークフローダイアログを起動してくださ

い。 

 

 Input Filesタブ → Auxiliary Files の横にあるフォルダマークをクリック → ファ

イルの選択ダイアログ → コネクショングラフで出力された auxiliary.sml ファイル

を選択 → 「開く」をクリックしてください。Refinement GCP File の設定は本手

順の最後に行います。 

 

図 13. Refinement and Re-flattening設定ダイアログ 

 

 次に、DEMの設定を行います。前の干渉画像作成処理で使用した DEMファイルを

使用します。DEM/Cartographic System タブ → DEM File の横にあるフォルダマ
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ークをクリック → ファイルの選択ダイアログから、DEM ファイルを選択 → 「開

く」をクリックしてください。 

 

図 14. DEM設定タブ 

 

 Parametersタブでは、処理に関する設定パラメータを変更することができますが、

殆どのケースでデフォルト値で問題なく実行できるため、本処理でも値を変更せず

に使用します。 

 

図 15. Parametersタブ 

Parametersタブの Principal Parameters について簡単な説明を以下に記載します。 

⚫ Rebuild All: Refinement and Re-flattening処理を全てのデータを使用し、再処理

を行います。一度処理を実行した後にパラメータなどの変更をし、再度処理を実施

する場合は、Trueにして実行します。既に処理済みのデータに対して、新しいデ

ータを追加して処理する場合は、Falseを設定します。 

⚫ Coregistration with DEM: コレジストレーション処理時に DEMを使用します。 

⚫ Refinement method: リファインメントの手法を Automatic Refinement、

Polynomial Refinement、 Orbital Refinementから選択します。 

⚫ Refinement Residual Phase Poly Degree: 位相ランプを推定するために使用され

る多項式の次数です。位相オフセットのみが必要な場合は、1を設定します。 

 

 最後に Refinement処理で使用する GCPを作成します。Input Files タブ → 

Refinement GCP File の横にある双眼鏡マーク をクリック → Generate Ground 
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Control Points ダイアログを起動します。GCPを作成するためのファイルを選択

し、Nextをクリックします。 

 

図 16. Input Filesタブ 

 

 Generate Ground Control Points ダイアログが起動します。コヒーレンスが高く、

変動のないところに 15点から 20点程取得します。今回は、干渉画像の_fint画像に

対して、コヒーレンスの_cc画像を参考に GCPを取得します。 

 

図 17. GCP作成に使用するファイル設定ダイアログ 

⚫ Input File: GCPを設定する位置を示すファイル 

上記設定ファイルは出力ファイルパス¥work¥work_interferogram_stacking 内に

ある_fint画像を使用します。 

⚫ DEM File: GCPの高さを示す DEMファイル 

上記設定ファイルは Interferometric Processingでも使用した DEMファイルで

す。 

⚫ Reference File: GCPを設定するために参考とするファイル 

上記設定ファイルは出力ファイルパス¥work¥work_interferogram_stacking 内に

ある_cc画像を使用します。 
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【補足】 

以下フォルダに、使用するデータの各ペアで算出された_fint、_upha、_ccのクイ

ックルックファイルがあるので、フォルダ内の画像のサムネイル表示や、windows

の画像ビューワで簡単に画像を確認することが可能です。クイックルックファイル

を参考にどのファイルを使用すれば良いかデータを確認し、決定することが可能で

す。 

クイックルックファイル: 出力ファイルパス¥interferogram_stacking¥interf_tiff 

 

 GCP作成用のデータが ENVIへ表示された後、各画像のデータ値が認識しやすくな

るように、_fint画像と_cc画像へ疑似カラーを付与します。 

 

 Layer Manager→_fint画像を右クリック→Change Color Tables→Rainbowを指定

し、画像を強調します。同じ操作を_cc画像にも行ってください。 

   

図 18. 左図: _fint画像  右図: _cc画像 

 

 ENVIのツールバーにある、Transparency を使用し、下の_cc

画像が参照出来るよう、透過度を変更します。画像全体に、_fint画像のインターフ

ェログラム画像で位相が安定している、コヒーレンスの値が高い箇所に対して、任

意の数だけ GCPを設定し、Finishをクリックします。 



 

16 

   

図 19. 左図: 設定した GCP  右図: GCP作成ダイアログ 

 

 GCPの処理が終了すると出力フォルダ直下へファイルが作成されています。また、

出力されたファイルは自動的に Input Files タブの Refinement GCP File へと設定

されています。Execをクリックします。処理が終了すると Reference File で指定し

た_fint画像と同じフォルダに「ファイル名_reflat_fint」画像が作成されます。 

 

図 20. GCP作成後の Refinement and Re-flatteningダイアログ 
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速度推定(1回目) 

ここでは、変動速度と高さの残差位相を算出するため、1回目の速度推定を実施します。

インターフェログラムを平坦化し、位相のアンラッピングとリファインメントを再実施し

ます。 

 

【操作】 

 ENVIツールボックス → SARscape → Interferometric Stacking → SBAS → 4 - 

Inversion: First Step を選択し、ワークフローダイアログを起動してください。 

 

 Input Filesタブ → Auxiliary Files の横にあるフォルダマークをクリック → ファイ

ルの選択ダイアログク → コネクショングラフで出力された auxiliary.sml ファイル

を選択 → 「開く」をクリックしてください。 

 

図 21. 速度推定(1回目)設定ダイアログ 

 

 Parametersタブは変更せず、処理を実行させるため「Exec」ボタンをクリックして

ください。 
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図 22. Parametersタブ 

Parametersタブの Principal Parameters について簡単な説明を以下に記載します。 

⚫ Product Coherence Threshold: コヒーレンス値がこの閾値より小さい値を持つピ

クセルは、結果画像でダミー(NaN)値が設定されます。 

⚫ Spatial Wavelet Size (m): 参照 DEMを設定値の解像度まで低解像度化し、残差

地形成分を推定し、それ以外の歪みに対してウェーブレット分解を実施します。 

⚫ Min valid interferograms %: このパラメータは 0以上の時に有効です。各出力グ

リッドポイントでのインターフェログラムの最小数の割合を設定します。 

⚫ Allow Disconnected Blocks: 取得したデータの一部がメインのコネクションに含

まれず、別のコネクションになっている場合は、Allow Disconnected Blocks オプ

ションを有効にすることで時間的間隔が開いた別のコネクションも変動の算出に

追加することが可能です。下にある Displacement Model Typeで選択したモデル

を適用し補間します。算出された結果の変動の信頼性は Allow Disconnected 

Blocksオプションを無効にしている時よりも低くなります。 

⚫ Displacement Model Type: Allow Disconnected Blocksを有効にした際に使用す

るパラメータです。Linear、Quadratic、Cubicから選択します。 

⚫ Estimate residual height: Trueの場合、残差地形の高さを推定します。高解像度

の DEMを使用している場合、20 枚未満の画像を使用している場合、このオプシ

ョンの使用は推奨されません。 

⚫ Stop Before Unwrapping: Trueに設定した場合、最後のフェーズアンラッピング

処理は実行されません。 
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⚫ Rebuild All: ファーストインバージョン処理を全てのデータを使用し、再処理を

行います。一度処理を実行した後にパラメータなどの変更をし、再度処理を実施

する場合は、Trueにして実行します。既に処理済みのデータに対して、新しいデ

ータを追加して処理する場合は、Falseを設定します。 

⚫ Inversion SVD type: インバージョン処理を SVD jacobi と SVD bdcから選択し

ます。 

⚫ Unwrapping Method: アンラッピングの手法を Region Growing、Minimum 

Cost Flow、Delaunay MCF から選択します。 

⚫ Unwrapping 3D: 三次元アンラッピング手法を使用します。コネクショングラフ

の Delaunay 3Dを True にした場合に使用可能です。 

⚫ Unwrapping Decomposition Level: マルチルック及びアンダーサンプリングの反

復回数を指定します。 

⚫ Unwrapping Coherence Threshold: アンラッピングの際にこの値より低い全て

のピクセルがマスクされます。 

 

 処理が終了すると、出力フォルダ配下の Inversionフォルダへ処理結果が含まれたメ

タファイルなどが出力されます。出力されたメタファイルの SI_model_first_meta フ

ァイルには初期速度推定画像（SI_velocity_first_est）などが含まれます。その他、

interf_tiffと slant_range_modelというサブフォルダが作成され、それぞれこの処理

で実施された干渉処理の TIFFファイルとスラントレンジジオメトリデータが出力さ

れています。 

                

図 23. Data Manager内の出力ファイル 
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速度推定(2回目) 

2回目の速度推定処理です。ここでは、前処理で取得した最適化されたアンラップ画像を

使用し、再度変動速度や残差高さの推定を行い、これらの推定された位相を観測した位相

から取り除き、大気やその他の影響による位相を推定して、ノイズとして除去します。 

 

【操作】 

 ENVIツールボックス → SARscape → Interferometric Stacking →SBAS → 4 - 

Inversion: Second Step を選択し、ワークフローダイアログを起動してください。 

 

 Input Filesタブ → Auxiliary Files の横にあるフォルダマークをクリック → ファ

イルの選択ダイアログ → コネクショングラフで出力された auxiliary.sml ファイル

を選択 → 「開く」をクリックしてください。 

 

 Refinement GCP File の横にあるフォルダマークをクリック → ファイルの選択ダ

イアログ → Refinement and Re-flattening処理で作成した GCPファイルを選択 

→ 「開く」をクリックしてください。 

 

図 24. 速度推定(2回目)ダイアログ 

 

 Parametersタブの値の変更はありません。処理を実行させるため、「Exec」ボタ

ンをクリックしてください。 
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図 25. Parametersタブ 

Parametersタブの Principal Parameters について簡単な説明を以下に記載します。 

⚫ Product Coherence Threshold: コヒーレンス値がこの閾値より小さい値を持つピ

クセルは、結果画像でダミー(NaN)値が設定されます。 

⚫ Min valid interferograms %: このパラメータは 0以上の時に有効です。各出力グ

リッドポイントでのインターフェログラムの最小数の割合を設定します。 

⚫ Interpol. Disconnected Blocks: このパラメータを True に設定すると、変動結果

が算出されていない部分に対して変動測定値を推定します。算出されていないギャ

ップ前後の測定値から推測されるため、信頼性は慎重に評価してください。このパ

ラメータと上下にある(Min valid interferograms %、Min valid acquisition %)パ

ラメータを使用し、ギャップ間の変動を推定します。 

⚫ Min valid acquisition %: このパラメータは 0以上の時に有効です。各出力グリッ

ドポイントでのインターフェログラムの最小取得数の割合を設定します。 

⚫ Atmosphere Low Pass Size: 大気変動の空間分布範囲を設定します。設定値が小さ

いと局所的な変動の補正に適し、大きいと広域な変動を補正するのに適していま

す。 

⚫ Atmosphere High Pass Size: 大気変動の時間的分布を設定します。頻繁発生して

いる大気変動を補正するには設定が小さい方が適しています。一時的な変動が少な

い場合は設定値が大きい方が適しています。 

⚫ Rebuild All: 2回目のインバージョン処理を全てのデータを使用し、再処理を行い

ます。一度処理を実行した後にパラメータなどの変更をし、再度処理を実施する場

合は、Trueにして実行します。既に処理済みのデータに対して、新しいデータを

追加して処理する場合は、Falseを設定します。 
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⚫ Inversion SVD type: インバージョン処理を SVD jacobi と SVD bdcから選択しま

す。 

⚫ Refinement method: リファインメントの手法を Automatic Refinement、

Polynomial Refinement、 Orbital Refinementから選択します。 

⚫ Refinement Residual Phase Poly Degree: 位相ランプを推定するために使用され

る多項式の次数です。位相オフセットのみが必要な場合は、1を設定します。 

 

 処理が終了すると、出力フォルダ配下の Inversionフォルダへメタファイルなどが

出力されます。出力されたメタファイルの SI_model_meta ファイルには平均変動速

度画像（SI_velocity）などが含まれます。 

 

図 26. Data Manager内の出力ファイル 

 

【補足】 

ここで使用する GCP ファイルは不動点を示すものです。マニュアルでは Refinement

で使用した GCPを使用する手順ですが、必要であれば新たに設定してください。 
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ジオコーディング 

算出された結果に地理情報を付与し、ラスタやシェープファイルに保存します。 

 

【操作】 

 ENVIツールボックス → SARscape → Interferometric Stacking → SBAS → 5 – 

Geocoding を選択し、ワークフローダイアログを起動してください。 

 

 Input Filesタブ → Auxiliary Files の横にあるフォルダマークをクリック → ファ

イルの選択ダイアログク → コネクショングラフで出力された auxiliary.sml ファイ

ルを選択 → 「開く」をクリックしてください。 

 

図 27. ジオコーディングダイアログ 

 

 DEMの設定を行います。DEM/Cartographic System タブ → DEM Fileの横にあ

るフォルダマークをクリック → ファイルの選択ダイアログから、DEMファイルを

選択 → 「開く」をクリックしてください。 
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図 28. DEM設定タブ 

 

 Parametersタブの値の変更はありません。処理を実行させるため、「Exec」ボタ

ンをクリックしてください。 

 

図 29. Parametersタブ設定項目上部 

 

図 30. Parametersタブの設定項目下部 

Parametersタブの Principal Parameters について簡単な説明を以下に記載します。 

⚫ Height Precision Threshold: 高さ推定に対する平均精度の上限の閾値を設定しま

す。単位はメートルです。 

⚫ Velocity Precision Threshold: 変動速度推定に対する平均精度の上限の閾値を設定

します。単位はmm/年です。 
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⚫ Product Temporal Coherence Threshold: 設定した閾値以下の時間的コヒーレンス

値を持つピクセルは、ダミー(NaN)値が設定され出力されます。 

⚫ Water Mask (db): 平均強度画像から水域マスクを作成する目的で使用します。単

位は dbです。設定した閾値以下のピクセルにマスクが設定され出力されます。 

⚫ Rebuild All: ジオコーディング処理を全てのデータを使用し、再処理を行います。

一度処理を実行した後にパラメータなどの変更をし、再度処理を実施する場合は、

Trueにして実行します。既に処理済みのデータに対して、新しいデータを追加し

て処理する場合は、False を設定します。 

⚫ Make Geocoded raster: Trueに設定すると、ラスタ形式のファイルを出力しま

す。 

⚫ Make Geocoded Shape: Trueに設定すると、シェープ形式のファイルを出力しま

す。 

⚫ Shape Max Number of Points: -1以外の数字が入力されている場合、有効になり

ます。シェープファイルを設定数だけ分割して保存します。 

⚫ Generate Shape Time Series: 時間に伴う変動をシェープ形式のファイルで出力し

ます。 

⚫ Vertical Displacement: 視線方向の変動を垂直方向への移動と仮定した変化量を出

力します。 

⚫ Slope Displacement: 視線方向の変動を水平方向への移動と仮定した変化量を出力

します。 

⚫ Displacement Custom Direction: Trueに設定すると、任意のベクトル方向へ移動

と仮定した変化量を出力します。Azimuth Angle(北からの角度で時計回り方向を

指定)と Inclination Angle(水平面からの角度で傾斜角を指定)が有効になります。 

⚫ X Dimension (m): X(東)方向のグリッドサイズを定義します。単位はメートルで

す。地図投影法の場合、0.2以上の数値はメートル単位として扱い、メートルから

度に変換されます。それ以下の場合は、度として扱い、変換なしで使用されます。 

⚫ Y Dimension (m): Y(北)方向のグリッドサイズを定義します。単位はメートルで

す。 

⚫ Mean Window Size: 高さ推定画像に対して実行する平均値フィルタのウィンドウ

サイズを設定します。値が 0の場合、フィルタ処理は実行されません。フィルタ処

理は補間処理後に実施されます。 

⚫ Interpolation Window Size: 出力ファイルのダミー値を補間します。補間値は指定

したサイズのウィンドウ内の有効値の平均です。値が 0 の場合、補間は実行されま

せん。 

 

 結果を表示(load)するか聞かれますので、ENVIへと表示してください。

SI_disp_geo_metaファイルは地理情報が付与された変動速度の値を持ったデータで
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す。日付ごとの変動と SI_velocity_geo以外の他データも含まれています。手動で読

み込みを行う場合は、以下のファイルを ENVIで開いてください。 

出力先: 指定出力先フォルダ¥inversion¥ SI_disp_geo_meta 

 

図 31. データマネージャ内の出力ファイル 

 

 結果を確認します。データマネージャ → SI_disp_geo _metaファイルの

SI_velocity_geoを選択 → 右クリックし、Load Grayscale を選択します。表示され

たデータを Layer Manager で右クリック → Change Color Table → Rainbowを

選択してください。 

 

図 32. 変動データの読み込み 
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図 33. 疑似カラーを付与した結果の表示 

 

 カーソルで指定したピクセル値のグラフを表示します。ENVI ツールボックス → 

SARscape → General Tools → Time Series Analyzer → Rasterを選択し、確認

したい場所へカーソルを移動し、「Plot」ボタンをクリックすることで、任意のポ

イントの時系列の変動を確認することができます。 

 

図 34. グラフの表示 

 

お問い合わせ先 

本チュートリアルに関する、ご質問やご要望に関しましては以下のメールアドレスまでご

連絡をお願いいたします。 

Harris Geospatial 株式会社 

サポート窓口： 
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support_jp@L3harris.com 


